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Rohde&Schwarz Products: Handheld Spectrum Analyzer R&S®FSH 

 

FSHRemote 
Remote Control and Data Access 

for the R&S®FSH 
 

Application Note 1MA70 
FSHRemote is a program for reading data and controlling a Handheld Spectrum Analyzer R&S®FSH from a 
remote computer. 

The physical connection can be via either a fixed phone network, a mobile phone network or LAN/Internet. 
Use FSHRemote from a PC to control all the functions of the FSH or to read any measurement data. 
Undertake a diverse range of monitoring tasks with the R&S®FSH under remote control. No need for a PC 
at the R&S®FSH end. 
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1 Introduction 
FSHRemote is a Program for connecting an R&S®FSH handheld spectrum 
analyzer to a remote computer, and providing complete control of all func-
tions from the computer. 

The physical connection can be either with a serial cable, a telefone modem 
connected to a fixed phone network (POTS), a mobile phone (or other 
wireless user equipment) over a mobile phone network, or via LAN/Internet 
using a serial server (LAN-RS232 converter). 

Use FSHRemote from a PC to remote control all the functions of the 
R&S®FSH or to read any measurement data. Undertake a diverse range of 
monitoring tasks with the R&S®FSH, such as spectrum analysis or power 
measurements.  

An important design feature of FSHRemote is that the R&S®FSH can be 
connected directly to a modem, mobile phone, or serial server (LAN-RS232 
converter); there is no need for a PC at the R&S®FSH end. 
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The Handheld Spectrum Analyzer R&S®FSH is abbreviated to FSH for the 
remainder of this Application Note. 

2 Software Features 
FSHRemote is simple to install and simulates the user interface of the FSH 
in a somewhat altered form on the screen of the PC. The following func-
tions are provided: 

 connection management between the PC and the FSH either: 
- direct device-to-device using the optical serial RS-232-C cable 
FSH-Z34 or the optical USB cable FSH-Z37  
- via a fixed phone network with two telephone modems 
- via a mobile phone network with two Mobile phones as wireless 
modems 
- via a fixed phone network with one telephone modem and one 
wireless modem 
- via LAN/Internet with a serial server (LAN-RS232 converter) and a 
LAN/Internet connection 

 frequency and measurement range settings 

 selection of type of measurement 

 level settings 

 marker functions 

 either manual trigger or continuous recording of measurement val-
ues 

 time-controlled reading and storing of measurement results 

 user defined scripts for measurement sequences 

 3D display of the measurements in waterfall and spectrogram 
mode 

 

3 Hardware and Software Requirements 

Hardware Requirements 
CPU: Pentium 300 MHz or better 

Hard Disk: 8 MBytes free 

Monitor: SVGA color monitor, resolution 800x600 or better 

Modem: either 56K telephone modems, GPRS mobile phones or wireless 
modems that can transmit data on two or more time slots (for example 
GPRS classes 6 or 10), or other appropriate mobile phones, or a serial 
server (LAN-RS232 converter), with a fixed IP address, providing long 
range connection through LAN/Internet host and a serial device. 

Note:  For better performance with the 3D display of the 
measurements a graphic card with hardware acceleration is 
recommended.. 
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Software Requirements 
Microsoft 32-bit operating system (Windows 95/98/NT/2000/ME/XP) 

FSH firmware version 5.0 or later 

Remote control software R&S®FSH-K1 must be activated in the FSH (order 
Option Key) 

 

4 Installing and Starting FSHRemote 
To install FSHRemote execute the file FSHRemote_<version number>.exe 
with a double click. The installation wizard is activated; the first option is 
choose the language (English or German) for the installation. 

Follow the instructions from the wizard. In the course of the installation se-
lect the directory of your choice in which the program is to be installed. 

FSHRemote requires approximately 8 MB RAM on a hard disk. The wizard 
also adds an entry for FSHRemote in the Start->Programs menu of the 
computer. 

No other parameters are required for installation. 

For de-installation, Rohde & Schwarz supplies the program uninstall.exe, 
which removes FSHRemote completely from the computer. 

Warning:  De-install removes the program files and also the directory in 
which FSHRemote in installed. Make sure you have archived 
any other files or subdirectories present in the directory before 
de-installation. 

To start the program select FSHRemote from the Program submenu in the 
Windows Start menu. When FSHRemote starts, the Registration form ap-
pears. Please register the installation; it is free and does not result in any 
further commitments for you or your company. 

If FSHRemote has not been registered, you can still start the program by 
clicking the Continue button. 
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Fig 1 Registration form 

 

If you complete the Registration form, you will be sent a keycode. Enter the 
code into the Registration form and click the Continue button. The Main 
Window for FSHRemote appears. 

Once FSHRemote has been registered, the registration form does not ap-
pear any more. 
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Fig 2 FSHRemote Main Window 

 

 

5 Connecting the Computer to the FSH 
There are five options for transferring data between the PC and the FSH: 

- Direct device-to-device using either the Optical RS-232-C cable 
FSH-Z34 or the Optical USB Interface cable FSH-Z37 supplied with 
the FSH. If your FSH came with the Optical USB Interface cable 
FSH-Z37, please see Appendix E and Connecting the PC, FSH and 
Modems or Serial Servers (LAN-RS232 Convertors) – TCP/IP 
Connection with two PCs for further information. 

- Via a fixed phone network with one telephone modem and one wire-
less modem. 

- Via a mobile phone network with two mobile phones (or alternative 
suitable wireless devices) as wireless modems. 

- Via a fixed phone network with two telephone modems. 

- Via LAN/Internet with a serial server (LAN-RS232 converter). This 
option requires some basic knowledge of the necessary settings 
needed for a successful TCP/IP connection 

Configuring the Communication Devices 
Before first use you have to configure the modems or mobile phones in use, 
as required for all the communication options apart from the direct device-
to-device connection with the serial optical cable. From the Utility menu se-
lect Set Devices. The device at the FSH-end must be configured to com-
municate with the PC. 
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Fig 3 Modem Selection 

 

1. Configuring the modems/mobile phones: 

From the Available Devices drop-down menu, select the device to config-
ure. The AT instructions required to configure a modem or mobile phone 
are stored in the SETTINGS.INI file, which are stored in the same directory 
as FSHRemote. For further information about SETTINGS.INI see Appen-
dix A.  

As the majority of modems are functionally compatible, you can use the set-
tings for the Creativ Labs modem for many other modems too. The settings 
for mobile phones are also extremely similar, so that the values from the 
supplied SETTINGS.INI can often be used. 

Select or enter manually the COM port to which the device is connected. 
The default baud rate is 19200, which is more than adequate. Click on the 
button Set Device to store the configuration. Once the values are saved the 
Set Device window disappears. 

Store the selected values in the modem. If, as is the case with some mobile 
phones, the values cannot be stored, either leave the mobile phone 
switched on, or re-enter the values each time after switching the mobile 
phone on. 

 

2. Configuring a serial server(LAN-RS232 converter): 

In the case of an LAN/Internet connection the usage of the Set Device dia-
log box is not possible as every serial server has its own way of saving its 
settings. There are several main parameters, which have to be set: 

1. The IP address of the server: After setting a fixed IP address for the 
server, this will be the address which FSHRemote uses to access FSH. 
The IP address must be fixed and not dynamically allocated - FSHRe-
mote does not scan the entire domain, but connects to a specified IP 
address. The instructions on setting a fixed IP address for your serial 
server can be found in its documentation. 

2. The logical port of the server: This is the second main parameter to 
establish a TCP/IP connection and corresponds to the TCP layer. A se-
rial server may have a number of available ports. When used as a host, 
it listens on a particular port for a connection request. This is the port, 
on which the service for converting network and RS232 data is avail-
able. There are serial servers on which you can associate any port with 
this service, and some where it is fixed and cannot be changed. Please 
refer to your serial server’s documentation for instructions on altering 
the port for the TCP/IP connection. 

3. Operating mode: In the case of listening for a connection request, the 
serial server has to be set in Host-Based mode. Please refer to your se-
rial server’s documentation for its available operating modes. 
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4. Once the network settings allowing the serial server to communicate 
with the network have been made, one of its serial ports has to be set 
accordingly, to be able to establish a connection to the FSH via its opti-
cal cable. The main parameter to be set here is the baud rate – it must 
be the same as the baud rate set on the FSH. Any baud rate, which is 
supported by both the serial server and the instrument is applicable. 
We recommend using the highest baud rate of 115200. Please refer to 
your serial server’s manual for instructions on setting the baud rate of 
its RS232 ports. 

5. Additional notes: 

a. Some serial servers need a special null modem adapter (cross 
link cable) to be able to connect to the FSH optical cable. 
Please see the appendix for the wiring of such an adapter. 

b. In our tests for this purpose we used the serial server of Moxa 
Inc. NPort Express. Another serial server which we have 
tested, is the AXIS 2490 Serial Server from AXIS Communica-
tions. A special setting, which has to be made here is to deacti-
vate its telnet options as otherwise there are problems with bi-
nary data transfers. In this case no additional null modem 
adapter is necessary to connect to the FSH optical cable. 

 

 

Connecting the PC, FSH and Modems or Serial 
Servers (LAN-RS232 Convertors) 
From the Connection menu select the connection method used: 

- Direct Serial Port Connection. 

- Two Modems Connection with a telephone modem at each end. 

- Two Mobile Phones Connection with a mobile phone at each end. 

- Modem to Mobile Phone Connection with a telephone modem con-
nected to the PC and a mobile phone at the FSH. 

- Mobile Phone to Modem Connection with a mobile phone connected 
to the PC and a telephone modem at the FSH. 

- TCP/IP Connection with the FSH connected to a serial server, which 
is connected to the network and a PC with a network connection. 

 

Fig 4 Connection Menu 
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Note: The direct connection is particularly useful for getting started with 
FSHRemote and the FSH, as the reaction of the FSH to instruc-
tions from the program are simple to observe. The data transfer 
rate is the fastest possible, and is not subject to additional delays 
also possible with, for example, a wireless modem. The data 
transfer is free, too! 

 

 

Direct connection via the serial or USB port: 

If the computer is close to the FSH, it can be connected directly to the PC 
using either the Optical RS-232-C interface cable FSH-Z34 or the Optical 
USB interface cable FSH-Z37 supplied with the FSH. If your FSH came with 
the Optical USB Interface cable FSH-Z37, please see Appendix E for 
further information.. 

Once the cable has been connected at both ends, select Direct Serial Port 
Connection. 

The Connect window opens to set the connection data. Select the COM 
port and the baud rate and click on Connect. Make certain the value for 
baud rate matches the value set up for the FSH; otherwise the connection 
fails and FSHRemote displays an error message. 

 

Fig 5 The Connect window for Direct Serial Port Connection 

 

Once the connection has been established, the serial number of the con-
nected FSH is displayed and the Connect window is closed. 

 

 

With a telephone modem at each end: 

Make sure to have set up the modem at the FSH end according to the in-
structions given above. Connect one modem to the PC and the fixed phone 
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network, and the other to the FSH using the optical RS-232-C serial cable 
and (of course) also to the telephone line. 

As both the FSH and the modem are data end equipment of equal status, 
an additional null modem (crosslink) cable must be connected to the RS-
232-C cable using a male-male gender changer. Small adapters with these 
functions are also commercially available (see picture). 

 

Fig 6  Connect the FSH to a modem or mobile phone using a null modem 
adapter (crosslink cable) and a male-male gender changer 

 

To establish the connection select Two Modems Connection from the Con-
nection menu. The Connect window opens to specify the connection set up. 

 

Fig 7 The Connect menu for Two Modems Connection 
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Select the COM port and the baud rate for the PC side of the connection. 
As the modem is connected directly to the PC a relatively high data rate (up 
to 115 kbaud) can be selected. 

The baud rate that the modem on the FSH side uses to transfer data is 
specified in the SETTINGS.INI file. If 19200 baud is selected, the FSH must 
be set up for 19200, too. See additional information in Appendix A. 

Data transfer with 19200 baud should always be possible with a 56-k mo-
dem. For higher data rates, perform a test. Enter the telephone number of 
the target modem and click on Dial Number. If the connection is success-
fully established, a picture of an FSH appears on the FSHRemote main 
menu beneath the Measure button. 

 

Note:  Some modems and mobile phones cannot sufficiently supply 
the optical RS-232-C serial cable with power. A separate 
power supply and buffer amplifier must be incorporated in the 
set up instead of the null modem adapter and the gender 
changer. A circuit diagram for a suitable buffer amplifier is in-
cluded in Appendix A. 

 

 

With a mobile phone at each end 

Make sure to have set up the mobile phone at the FSH end according to the 
instructions given above. Connect the PC to a mobile phone using the serial 
cable supplied with the GPRS mobile phone (or wireless terminal). Connect 
the FSH to the other mobile phone using the optical RS-232-C serial cable, 
with a null modem adapter and a male-male adapter as described above for 
a telephone modem. 

To establish the connection select Two Mobile Phones Connection from the 
Connection menu. The Connect window opens to specify the connection 
set up. 

Select the COM port and the baud rate for the PC side of the connection, as 
determined by the attached mobile phone. The baud rate that the mobile 
phone on the FSH side uses to transfer data is specified in the 
SETTINGS.INI file and is stored in the mobile phone with Set Devices. If 
19200 baud is selected, the FSH must be set up for 19200, too. 

We recommend the use of 2 GPRS mobile phones with a baud rate of 
19200 baud. See additional information in Appendix A. 

Enter the data (!) telephone number of the mobile phone attached to the 
FSH and click on Dial Number. The connection can take several minutes, 
please be patient. If the connection is successfully established, a picture of 
an FSH appears on the FSHRemote main menu beneath the Measure but-
ton. 

 

 

Mixed telephone modem and mobile phone modem connection: 

Connect the modem and mobile phone to the PC and FSH as described 
above. 

Enter the connection data, as described above, using Connection - Modem 
to Mobile Phone Connection or Connection - Mobile Phone to Modem Con-
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nection as applicable. We recommend a baud rate of 19200 for the con-
nection. 

 

Note:  Each window includes the buttons Save Settings and Load 
Settings. Save Settings saves the current settings for COM 
port, baud rate, and phone number. Load Settings recalls the 
last saved settings. No need to re-enter the same data each 
time a connection is established. 

 

Fig 8 Saving and recalling connection settings 

 

Warning:  If an FSH running in battery mode is switched off and back on, 
the baud rate is reset to 19200. If you are working with higher 
baud rates, de-activate the Auto Power Down function and 
connect FSH to an uninteruptable power supply. 

 

 

TCP/IP connection with a serial server (LAN-RS232 converter) and a net-
work connection: 

Make sure to have set up the serial server at the FSH end according to the 
instructions given above. Connect the PC to the LAN/Internet network, and 
the serial server to the FSH using the optical RS-232-C serial cable, and to 
the network. 

 

Fig 9 LAN/Internet connection using the TCP/IP protocol 

As both the FSH and the serial server may be data end-equipment of equal 
status, an additional null modem (crosslink) cable may have to be con-
nected to the RS-232-C cable using a male-male gender changer. Small 
adapters with these functions are commercially available. There are also 
serial servers, which do not need these additional adapters. Refer to the 
manual of your serial server to see which is the case.  
To establish a connection to the serial server with the specified IP address, 
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it has to match the range of IP addresses the PC with FSHRemote can 
communicate within its current sub group. This range of addresses is de-
termined by the setting of the PC’s own IP address and the network sub-
mask setting, which can be found in the Control Panel / Network settings 
under “Properties” for the “Internet Protocol” (TCP/IP) components. The IP 
communication protocol can be tested by opening a command prompt and 
typing in the following command: 

C:\>ping <hostname> 

If the serial server is not visible you may have to change the settings of its 
IP address, network sub-mask, (standard gateway). Please refer to the 
manual of your serial server in this case. 

 

Fig 10 TCP/IP Connection dialog box 

 

Note:  You can also use the name of the computer in the network 
instead of an IP address: 

 

Fig 11 TCP connection using a computer name instead of an IP address 

 

Note:  The settings for the IP address and the port number in the 
TCP/IP Connection dialog box are automatically saved after a 
connection has been established, so that you don’t have to 
enter them manually every time. 

 

Warning:  If a FSH running in battery mode is switched off and back on, 
the baud rate is reset to 19200. If you are working with higher 
baud rates, de-activate the Auto Power Down function and 
connect FSH to an uninteruptable power supply. 
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TCP/IP connection with two PCs: 

A special server functionality has been included in FSHRemote so that 
communication between two PCs each running an instance of FSHRemote 
is possible. This is especially useful when no serial server hardware is 
available or the FSH instrument is controlled via its Optical USB Interface 
Cable FSH-Z37 (see Appendix E: Optical USB Interface Cable FSH-Z37) 
so that the usage of a serial server with an RS232 interface is not possible. 

 

Fig 12 TCP/IP connection with two PCs 

In order to start the server functionality of FSHRemote use “Utility->Start as 
Server…” 

 

Fig 13 Start the server functionality 
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The following dialog box appears: 

 

Fig 14 Server window 

This window is separated into two blocks. The left one is used to indicate 
the IP address of the host PC (read only) and the port on which the server 
should listen for incoming connection requests. Use these settings when 
choosing “Connection->TCP/IP connection” on the local instance of 
FSHRemote.  

The right side of the window contains settings of the connection to the COM 
port, where the FSH instrument is connected. The program automatically 
detects if an FSH instrument is present on the specified COM port and sets 
it to the highest baud rate for a faster communication. 

The “Connect” button starts the server with the specified settings: 

 

Fig 15 Successful connection 
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After a successful connection the “Connected” picture and the “Disconnect” 
button are displayed. The FSHRemote server is now ready to receive 
connections on the TCP port specified in the “TCP Settings” block of the 
window.  

At the local side use the same procedure as described in “TCP/IP 
connection with a serial server (LAN-RS232 converter) and a network 
connection” to connect to the server. 

After a clients requests a connection to the FSHRemote server, its IP 
address is displayed in the window: 

 

 

Fig 16 Client requests connection 

 

Pressing the “Disconnect” button disconnects the server and “Cancel” sets 
the program to its initial state. 

 

Starting FSHRemote in server mode at windows startup: 

This feature is useful when using FSHRemote as server at a remote 
location where an operator is not physically present. It allows automatic 
start and connection of the FSHRemote server to the FSH instrument 
making it available for clients even after a power failure. This feature 
assumes that after a power failure the remote computer restarts itself and 
loads windows.  

To activate this feature check the “Run on Startup” option: 

 

Fig 17 Run FSHRemote server on windows start 

Activating this option will automatically launch FSHRemote in its server 
mode the next time windows starts and try to connect it to an FSH 
Instrument. 
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6 Operating FSHRemote 
Once a connection is established between the FSH and the PC, FSHRe-
mote displays "Connected" in its main window, a picture of an FSH and at 
the bottom of the main window the elapsed time since the connection has 
been established. 

 

 

 

 

Fig 18 The display once a connection is established 

 

Setting the FSH 
FSHRemote provides access to all the functions that can be set directly on 
an FSH: 

 Frequency 

 Span 

 Level settings 

 Bandwidth 

 Sweep 

 Trace 

 Marker functions 

Additionally, the Measure Button and the switches that appear on the lower 
right provide access to all the measuring options of the FSH such as Ana-
lyzer, Tracking, Pwr Sensor, TDMA Power, Chan Pwr, Occ BW, Dist Fault 
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and Special.Meas. The PR and Disconnect buttons are only available while 
a connection to the FSH exists. PR activates a PRESET of FSH, Discon-
nect ends the connection. 

Use the input field to the left of the Send button to manually input any com-
mand from the "Remote Control for R&S FSH FSH-K1" Operating Manual. 
The field to the right shows the response from the FSH. Note that all com-
mands must be preceded by a CMD, GET or SET, followed by the required 
command. Example: CMD Send PRESET Send presets the FSH. You may 
use the Return key of your PC instead of the Send button to send your 
commands to FSH. 

Example: Read the Measured Spectrum 
The arrow key  on the upper right retrieves the current measurement 
data from the FSH. The time required depends on the type of connection. 
With a modem to modem fixed line connection, the retrieval time is less 
than an second; for a GPRS connection the retrieval can take up to 4 sec-
onds depending on the quality of the mobile radio connection. The sweep 
time must be added, too. For each query the FSH sends about 1.2 kByte 
data to the PC (2.4 kByte if Auto Peak Detector is used). 

The  key requests continuous reading of the measurement data. The 
repeat rate depends on the type of connection. For a GPRS connection and 
a short sweep time, a rate of about one measurement every 4 seconds is 
obtained and for a fixed line connection - about 1 measurement every sec-
ond. If sweep time is set to values above 1 second, repetition rate is de-
creased accordingly. 

In Continuous mode, stop data retrieval with the  button before entering 
a command.  

At any time you can click on the button named “3D” in the lower right corner 
of the two dimensional graph, where the trace is displayed. This opens the 
3D Representation window allowing you to view your data in a three 
dimensional format especially useful for waterfall display. If you stop the 
continuous displaying with the stop button and then resume it again with the 

 button, the 3D display will not be cleared but will display the next trace 
after the last one. Clearing the graph is done explicitly by using the View-
>Clear Graph command. 

For detailed instructions on using this feature please refer to Appendix B – 
“3D Data Representation”. 

To read the current values, click on the software button as appropriate. To 
establish the center frequency set on the FSH, first click on the Frequency 
button. Beneath the measurement display, user interface elements for set-
ting the FSH frequency appear; click on Center Frequency, to send the 
query from FSHRemote to the FSH. The current value for center frequency 
is displayed beneath the buttons. 

Note:  If you are working in single sweep mode and wish to initiate a 
new sweep, click on the  button. If you only wish to update 
the display without initating a new sweep, click on the  but-

ton and then on the  button. 

To alter a value enter the new value in the window and press Return. Enter 
the value in either: 
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- scientific notation. For example; 100e-3 for 0,1 or 98,5e6 for 
98,5 MHz) 

- suitable SI abbreviations for the unit. For example; 100 m for 100e-3 
or 10 M for 10e6 

- decimal separator: use , (comma) or . (dot) according to the country 
settings of your operating system 

Almost all the functions provided by the FSH can be used. To work with 
markers, click on the Marker button. FSHRemote checks which markers 
are active and displays them in the measurement curve. Switch on the 
marker, respectively the delta marker, by activating the selection box 
Marker On/Off or Delta On/Off. read the current values of the markers use 
the soft buttons beneath the measurement display. In order to set a new 
value for a marker enter the new setting in the text filed beneath its soft 
button and press ENTER. The marker goes to the specified new position. 

Note the status messages displayed at the bottom of the FSHRemote win-
dow. These messages show information about the current action as well as 
the time required for the action. Before beginning a new action, wait until 
the "finished" message from the preceding action is displayed. 

 

Fig 19 Status Messages 

 

Note:  Some functions of the FSH require the connection of measure-
ment bridges, calibration standards or similar equipment. In 
remote operation, an operator must have access to the FSH to 
complete the test set up. Only use such functions when the 
correct set up has been confirmed. 

Note:  In order to keep the data traffic low FSHRemote keeps track of 
the main FSH settings such as the frequency, span, etc. in an 
internal database. Click on the soft buttons underneath the 
measurement display to update these values. If the instrument 
is presetted using the PR button these values are presetted as 
well. 

 

Saving measurement data: 

The File menu includes functions to save measurement data. 
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Fig 20 The File Menu 

Save Current View writes the currently displayed data to an ASCII file. De-
pending on the detectors activated, frequency and the accompanying level 
values, or frequency, minimum and maximum levels (with the AUTOPEAK 
detector) are stored. The file is in CSV format and is compatible with the 
FSHView software. Traces stored with FSHRemote can be loaded into 
FSHView and vice versa. Exceptions are the Power sensor mode and the 
Receiver mode of the FSH instruments where the two programs are 
incompatible yet. 

 

Fig 21 The Sweeps saved with FSHRemote are loaded into FSHView 

 

Use Load data to recall and display a set of stored values. 

Note: Sweeps saved with earlier versions of FSHRemote may have 
problems with the scaling of the graph when displayed. If that 
is the case use the “Graph Settings” dialog box to rescale the 
graph manually. You can access this dialog box from Utility –> 
Graph Settings. 
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Fig 22 The Graph Settings dialog box 
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Record Data writes the current values at a time interval which can be set to 
any value from 1 second to about 50 days. Select Record Data and enter 
time interval in the Record Time Interval dialog box: 

 

Fig 23 The Record Time Interval dialog box 

 

If FSH is set to external triggering, you are asked to enter a timeout value 
for external trigger instead. If no external trigger occures within the timeout 
period recording of data is stopped and has to be started again.  

 

 

Fig 24 External Trigger Timeout dialog box 

 

Click Submit and enter the name of the file to store the data in. The 
smallest possible interval is determined by the type of connection between 
the PC and the FSH. With a mobile radio connection, data transfer can be 
up to 4 seconds, which has consequences for the minimum interval. Add 
sweep time, if sweep time is set to values above 1 second. 

To stop recording data, click on . 

You can view your saved data by clicking File->Load Data. If you have 
saved more than one set of trace data the sets are displayed one after the 
other in the 2D display and in a waterfall or spectrogram manner in the 3d 
display. For further instructions on using the 3D representation please refer 
to Appendix B – “3D Data Representation”. 
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Special Measurement Mode 
The Special Measurement function allows the user to create and execute 
user defined scripts in order to operate the FSH spectrum analyzer. The 
syntax of these scripts is based on the FSH-K1 command syntax - CMD, 
GET and SET with corresponding parameters - and has some additional 
commands described in Appendix C: Special Measurement Commands. 
Some examples are provided in subdirectory SpecialMeas of FSHRemote 
installation directory. 

 

Fig 25 Special Measurement Window 

 

Steps in order to create and use a script for a special measurement: 

Click the "Special Meas" button 
in the lower right corner of 
FSHRemote 

 

The Special Measurement 
dialog box opens 

 

Select "Open" to open or create 
a new script file (in .txt format) 
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Click on "Edit" to edit the 
current script within the buit-in 
text editor. Since the script files 
are stored as pure ASCII text, 
they may be edited with any 
other text editor as well (e.g. 
notepad.exe) 

 

If you have not specified a file to 
save the measured data from 
FSH during the execution of the 
script, you can do it by marking 
the "Save Data" check box. 
Within the script you can also 
instruct FSHRemote to save the 
data into file by using  the 
command: "saveresults 
<filename.csv>" 

 

Activate Step Mode check box if 
you want to run the script step 
by step. Stepmode can be 
activated during script 
execution by the command 
"stepmode". When in this mode 
the “Execute” button changes 
into a “Next” button, which 
allows you to execute the next 
command and jump to the line 
before the next one. It jumps 
over all the comment lines. 
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Activate Waterfall check box if 
you want to use the 3D 
representation and display the 
traces in a waterfall or 
spectrogram manner and not 
one by one. 

 

Click "Execute" to run the script 

Execution of the script can be 
stopped by clicking the "Stop" 
button 

"Close" exits the special 
measurement mode 

 

 

Note: If the "Save Results" check box has not been activated and the 
script contains any commands which read data from FSH, you 
are prompted to specify a file. You can overrule this by adding 
a NOSAVE entry to the script file. 

 

Please see Appendix C: Special Measurement Commands for a detailed 
description of the available commands. 

Sets of data recorded using the Special Measurement feature are saved 
into separate files which makes them faster to load and display in a loop 
from within a script using the “loadtrace” command than large sets of data 
recorded in a single file using Menu->Record Data. In order to slow down 
the process you can use the “pause <sec>” command in your script.  
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7 Additional Information 
This application note and the associated program FSHRemote are updated 
from time to time. Please visit the website 1MA70 in order to download new 
versions. After installation, the latest program information can be found in 
the file history.rtf in the installation directory. You can access this file also 
from link Programs/FSHRemote/History from your Start Programs folder. 

For general information about using the FSH and its features, see the FSH 
Operating Manual and the FSH-K1 (Remote Control) Operating Manual. 

Please send any comments or suggestions about this application note to 
TM-Applications@rsd.rohde-schwarz.com. 

Requests for support for your own programs for remote-controlling the FSH 
may also be sent to the above address. 

Please note further, that a complete solution for spectrum monitoring is 
available from Rohde&Schwarz called R&S® ARGUS Spectrum Monitoring 
System. FSH is well suited for integration into ARGUS. For detailed infor-
mation please refer to www.argus.rohde-schwarz.com or contact us via 
e-mail to argus@rohde-schwarz.com . 

8 Ordering Information 
Handheld Spectrum Analyzer 
R&S

®
FSH3 with Preamplifier 100 kHz to 3 GHz 1145.5850.03 

R&S
®

FSH3 with Tracking Generator 100 kHz to 3 GHz 1145.5850.13 

R&S
®

FSH3 with Tracking Generator 
and Preamplifier 

100 kHz to 3 GHz 1145.5850.23 

R&S
®

FSH6 with Preamplifier 100 kHz to 6 GHz 1145.5850.06 

R&S
®

FSH6 with Tracking Generator 
and Preamplifier 

100 kHz to 6 GHz 1145.5850.26 

R&S
®

FSH18 10 MHz to 18 GHz 1145.5850.18 
   
Remote Control (required)   
Remote Control R&S

®
FSH-K1  1157.3458.02 

RS-232-C Interface Cable FSH-Z34  1145.5815.02 
USB Interface Cable FSH-Z37  1300.7733.02 

 

For additional information about the FSH, see the Rohde&Schwarz website 
www.rohde-schwarz.com. Use "FSH" as a search string. 

http://www.rohde-schwarz.com/appnote/1ma70.html
TM-Applications@rsd.rohde-schwarz.com
http://www.argus.rohde-schwarz.com
mailto:argus@rohde-schwarz.com" 
www.rohde-schwarz.com
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9 Appendix A  

The SETTINGS.INI File 
The SETTINGS.INI file contains the commands to configure the modems 
and mobile phones used for the connection. Use any text editor to modify 
and extend the file. 

SETTINGS.INI consists of a number of blocks. The first block, DEVICES, 
contains the names of the modems used; enter the names of your choice. 
The supplied example file includes two telephone modems and two mobile 
phones. The following blocks begin with the names of the example devices, 
and include the commands for the corresponding device. 

 

[DEVICES] 
INIT1=MODEM_CREATIVE_FSH Modem at FSH, eg: Creative Labs 
INIT2=MODEM_ELSA_FSH  Modem at FSH, eg: ELSA 
INIT3=NOKIA6310_PC  Mobile phone at the PC eg: Nokia 6310,  
INIT4=NOKIA6310_FSH  Mobile phone at the FSH eg:Nokia 6310, 
 
[MODEM_CREATIVE_FSH]  commands for CREATIVE modem at FSH 
INIT1=ATQ0 
INIT2=AT&F 
INIT3=ATS0=1 
INIT4=AT&C0 
INIT5=AT+IPR=19200 
INIT6=ATQ1 
INIT7=AT&W0 
 
[MODEM_ELSA_FSH]  commands for ELSA modem at FSH 
INIT1=ATQ0 
INIT2=AT&F 
INIT3=ATS0=1 
INIT4=AT&C0 
INIT5=AT%B=19200 
INIT6=ATQ1 
INIT7=AT&W0 
 
[NOKIA6310_PC]   commands for Nokia 6310 at PC 
INIT1=ATQ0 
INIT2=AT+CGATT=1 
INIT3=AT&W0 
 
[NOKIA6310_FSH]   commands for Nokia 6310 at FSH 
INIT1=ATQ0 
INIT2=ATS0=1 
INIT3=AT+CGATT=1 
INIT4=AT+IPR=19200 
INIT5=ATQ1 
INIT6=AT&W0 
 

 

To define a modem, add the name to the DEVICES block and add a block 
with the defined name containing the AT commands for the modem. De-
vices that are not required can be deleted. 

The commands have the following meanings: 

ATQ0 switches the output of the modem result codes on. ATQ1 switches 
the output of the modem result codes off. 

ATS0=1 sets the modem to respond to an incoming call at the first ring tone 
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AT&W0 saves the settings permanently in modem memory 0 

AT+CGATT=1 switches a mobile phone into GPRS mode 

AT+IPR=19200 or AT%B=19200 sets the baud rate for the modem at the 
FSH end to 19200 baud. This baud rate must also be set as the Serial 
Baud-Rate in the setup of the FSH itself. 

 

Note:  The modem or mobile phone at the FSH must be configured 
using SETTINGS.INI prior to the first connection. At the PC 
end, the default values of modems can be used, mobile 
phones have to be configured as well. 

For further commands and information about the commands, please see 
the manual supplied with your modem or mobile phone. 

 

 

Recommended Wiring for a Null Modem Adapter 
The cables supplied with modems, mobile phones, and the FSH are nor-
mally intended for connecting the device to a PC. To connect the FSH to a 
modem or mobile phone, a null mode adapter is required to connect to the 
supplied cable. The diagram below shows the wiring required between two 
male plugs. 

Note that all pins on both ends are connected, apart from pin 9. 

 

Fig 26 Wiring for a null modem adapter 

 

The wiring can also consist of a null mode cable, connected to a gender 
changer to change the female plug into a male plug. 
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Recommended Wiring for a Buffer Amplifier 
Some modems or mobile phones do not have enough power or the neces-
sary level to power the FSH's optical RS-232-C cable. In such cases a 
buffer amplifier and 5V power supply is required. 

The assembly of an amplifier corresponding to the diagram below makes 
no particularly special requirements and can be assembled on a normal ex-
perimental board or with a simple printed circuit board. 

 

Fig 27 Wiring for a null modem adapter with a buffer amplifier 

 

The connections from pins 1,4 and 6, or 7 and 8, from the modem support 
the data handshake without which many modems will not function correctly. 
The connection from pin 2 on the modem side to pin 3 on the FSH side 
transfers data from the modem to the FSH. The connection from pin 2 on 
the FSH side to pin 3 on the modem side transfers data from the FSH to the 
modem. The connection to pin 7 on the FSH side provides power for the 
optical RS-232-C serial cable. 
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Additional notes 
Data telephone number: 

Some mobile radio operators provide a separate telephone number for data 
communications as opposed to the 'normal' number for voice calls. Only the 
data telephone number supports the necessary high baud rate for remote 
control. A connection to a voice call number with a data rate of usually only 
9600 baud will probably be too slow to operate the FSH successfully. 

Baud rate for telephone modems: 

The specified maximum modem baud rate usually only applies in the direc-
tion from the network to the PC or the connected terminal. In the other di-
rection from the PC to the network, the majority of modems have a maxi-
mum data rate of 33,000 baud. This is too slow to set the FSH for a baud 
rate of 38,400, so the FSH must be set for a baud rate of 19,200. The mo-
dem on the FSH side must also be set to this speed using the 
SETTINGS.INI file. 

Baud rate for mobile phone connections: 

The majority of mobile phone networks are optimised for maximum data 
rates from the base station to the mobile phone, too. The direction from the 
mobile phone to the base station, as required when the FSH connected to a 
mobile phone sends data, is mostly notably slower. 

Class 6 and class 10 GPRS mobile phones can in principle use two time 
slots to upload data, resulting in a maximum data rate to the base station of 
28,800 baud. However, this data rate is still not enough to operate the FSH 
with a quicker baud rate than 19,200. UMTS networks will be the first to of-
fer still higher data rates. In GPRS there is also an additional delay time in 
data transfer in both directions of about 0.5 seconds. 

Error messages: 

Error messages are generated when a function cannot run, or failed to 
complete. 

Some FSH models do not support all functions. For example, if the tracking 
generator is not built in, an error message is generated if an attempt is 
made to switch on tracking. The error code of the error message is dis-
played; for details see "Acknowledge Response" in the FSH-K1 Operating 
Guide. 

Internet connections and firewalls: 

If the local area network of the PC with FSHRemote and/ or the local area 
network of the serial server providing the FSH with an IP address (if they 
are not directly connected to the internet) are hidden behind firewalls, cer-
tain settings to these firewalls may have to be made, to allow the access in 
both directions. 

1. The serial server of FSHRemote is behind the firewall of its LAN: 
The firewall administrator has to open a port in the firewall and 
associate it with the service of the serial server so that it is visible 
from the outside world. Please note that opening ports in the fire-
wall may present a threat to the network from outside attacks. 

2. The PC with FSHRemote is behind the firewall of a LAN: 
In this case the administrator of the firewall has to allow this PC 
to access IPs outside the LAN’s domain. 
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10 Appendix B: 3D Data Representation 
FSHRemote allows you to view the trace data from the FSH instrument in 
three dimensional space in a waterfall or spectrogram display. 

To activate the 3D representation mode, click on the “3D” button located in 
the lower right corner of the default display: 

 

Fig 28 Button to activate the 3D representation 

 

The following window appears: 

 

Fig 29 3D Repsesentation window 

 

Each trace displayed in the default display is also shown here.  

There are three ways to obtain data sets for a waterfall/spectrogram view: 

- using the the  button to display the trace of the FSH 
continuously 

- load a file with more than one data set saved in it 

- start a script with the Waterfall  check box activated 
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The view of the graph can be adjusted with the View menu: 

 

Fig 30 Perspective waterfall 3D representation in continious display mode 

The same view in orthographic projection: 

 

Fig 31 3D orthographic projection 
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And as a spectrogram: 

 

Fig 32 Spectrogram display 

 

Note that you can also achieve these views by rotating, translating and 
zooming the graph using the mouse and keyboard. 

 

Moving the 3D display 
You can move the 3D Graph as you require for the view best meeting. 

Rotate by holding the left mouse button anywhere within the area of the 
display. Now moving the mouse will rotate the graph. 

To zoom in/out either use the mouse scroll button or hold down the  “ALT” 
key on the keyboard while moving the mouse away from you to zoom out or 
towards you to zoom in. 

Translating the graph in X, Y and Z directions is done by holding the 
“SHIFT” key on the keyboard and moving the mouse in the corresponding 
direction. 

You can also move the displayed traces within the graph in the X, Y and Z 
directions by holding one of the X, Y or Z keys and moving the mouse. 
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Using markers 
You can set an arbitrary number of markers on the displayed traces. To 
enter marker mode select from the Action menu: 

 

Fig 33 Using markers 

 

To set a marker just click anywhere on one of the displayed traces. While 
moving the mouse cursor over the trace, the number of the current trace, 
and the level and frequency ( or sweep time if in zero span) of the current 
point are continuously updated on the display: 

 

 

Fig 34 Set a marker 

 

Once a marker is set a new one automatically pops up. If you don’t want to 
set anymore markers click on the Move Graph command in the Action 
menu and the last marker, which has not been set yet disappears. 

Note: If you set a marker on a trace point of a trace which disappears 
after some time in the waterfall mode, the marker moves on to the 
point with the same frequency (sweep time) of the next trace 
indicating its new level and trace number. 

To delete the markers use Markers->Delete Markers 
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Simultaneous view 
Using the 3D Representation window you can display the data 
simultaneously in the default graph and in the 3d graph either in real time or 
as with saved data sets: 

 

 

Fig 35 Simultaneuous display 

 

Note: To see an example of loading a set of saved data into the waterfall 
display of FSHRemote you can start the waterfall example 
(waterFallLoad.txt) which is located in the directory 
SpecialMeas/waterfall_example. This example loads a set of 270 
files with saved traces. To do this first activate the 3D Display 
mode and then switch to the “Special Measurement” mode and 
open the file with the sript. Clicking on “execute” will execute the 
script and load the data. You can also load files recorded using the 
Record Data feature. 
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11  Appendix C: Commands for Special Measurement Mode 
The following commands are available for Special Measurement mode 
scripts. The commands can be written using upper or lower case letters. 

CMD CMD followed by a FSH-K1 
command executes this command. 

SET SET followed by a FSH-K1 
command executes this command. 

GET GET followed by a FSH-K1 
command executes this command. 
All results obtained by get 
commands are saved to result file 
unless NOSAVE is specified. 

GETSWEEP n Waits until the sweep is completed 
and reads its values. Use 
"savesweep" command to save 
measured values. For external 
triggering, n specifies a timeout 
value in seconds. Range for n is 
from 0 to 357913 (appr. 99 hours). 
This command is equivalent to GET 
TRACE. 

QUICKSWEEP Same as GETSWEEP, but does not 
retrieve settings information from 
FSH. Thus faster readout of FSH is 
possible. 

SAVESWEEP Saves sweep values to a result file. 
Depending on detector mode 301 or 
602 amplitude values and their 
corresponding frequency value is 
saved. 

LOADTRACE <filename.csv /.dat> Loads the saved trace from the 
selected file into FSHRemote. It can 
be used to load single traces or if 
called from within a loop - a waterfall 
display. Please have a look at the 
waterfall example in the 
SpecialMeas directory. 

SAVESCREEN <filename.wmf> Saves the current view of the default 
2D graph to the specified file 
<filename.wmf>. 

NOSAVE If NOSAVE command is specified in 
the script file, you are not promted to 
specify a results file and no results 
are written to file. This command is 
overruled by the Save Results 
checkbox and command 
"saveresults" 



 FSH Remote Control 
 

1MA70 _11E 37 Rohde & Schwarz 

PAUSE n Suspends script execution for n 
seconds, n = 1 to 357913 (appr. 99 
hours). If n is 0 or omitted, you are 
prompted to continue. Note that 
fractions of seconds are accepted 
too. 

DO - LOOP n Loops script execution n times for 
the block encapsulated by the do 
and loop instructions, n = 1 to 
32767. n = -1 allows endless 
execution of the loop 

WATERFALL ON/OFF Switches on or off the waterfall 
display of traces in the 3D 
representation graph. (same as 
checking the Waterfall checkbox). 

# <Script comments> Any line starting with a #-sign is 
considered to be a script comment 
line and is not executed. 

COMMENT <comment_text> Saves comment_text as comment to 
result file. If comment_text contains 
" i ", the actual value of the loop 
counter is saved to file. 

SAVERESULTS <resultfile.csv> Saves results to file <resultfile.csv> 
(same as checking Save Results 
checkbox). 

STEPMODE Switches on step mode during script 
execution (same as checking Step 
Mode checkbox). The script is 
executed step by step by clicking the 
Next button. Once this command is 
executed, stepmode remains on. 
Stepmode can be switched off by 
unchecking Step Mode checkbox. 
The rest of the script will be 
executed in normal mode then. 

SCANSTART frequency [HZ] Set a frequency to start a scan from. 
(See the FrequencyScan.txt 
example script) 

SCANSTEP frequency [HZ] Set a step for the frequency 
incrementation. (See the 
FrequencyScan.txt example script) 

SCANSTOP frequency [HZ] Sets a stop frequency for a scan. 

SCANLVLUPPL n [dB] Set an upper limit for the level 
(levels above this value are 
recorded) – Receiver Mode. (See 
the FrequencyScan.txt example 
script) 

SCANLVLLOWL n [dB] Set a lower limit for the level (levels 
below this value are recorded) – 
Receiver Mode. (See the 
FrequencyScan.txt example script) 
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AUTORECALL <dataset name>    Sets a dataset domain to recall 
instrument settings from. Please 
have a look at the 
“GenerateDataSetNamesAndFileNa
mes.txt” script 

AUTOLOAD <filename>    sets a file mask to load displays 
from. Please have a look at the 
“autoLoadTracesExample.txt” script 

 

Please note that the commands SCANSTART, SCANSTEP and 
SCANSTOP are designed to work together and the script will loop between 
the ScanStep and ScanStop statements. If needed you can also insert 
other statements within this loop e.g.:  

#*************************** 
# FSHRemote script 
#*************************** 
ScanStart 100e6 

ScanStep 10e4 

Get freq 

Get span 

Scanstop 107e6 

For further instructions please have a look at the frequencyScan.txt script 

Additional explanations can be found in the special measurement examp-
les, provided in the subdirectory SpecialMeas of the FSHRemote 
installation directory. 

Note: The SAVERESULTS command has been designed to accept 
filenames either with a normal file name or with a ‘*’ in them and 
thus generate a new file name using the current value of the index 
of a do loop.  

Example: 
SaveResults myRes_*.csv 

Do 

getsweep 

savesweep 

get freq 

get span 

Loop 3 

Will generate the following files: 

myRes_1.csv, myRes_2.csv, myRes_3.csv for the three sweeps 
and a myRes_VALUES.csv for the values of the frequency and 
the span. 

File Format of Script Files: 

The scripts are saved as pure ASCII text files. Besides the built in script 
editor of FSHRemote you can use any text editor such as notepad.exe to 
edit the files. Upper and lower case letters may be used. Be sure to save 
the script files as pure text files if you use other text processing programs 
such as Microsoft®Word or similar. 
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File Format of Result Files: 

Results are saved in a file format, which can be read directly from Micro-
soft®Excel. The saved values are separated by a semicolon ";". If the file 
extension was specified as .csv, the file can be directly processed by Mi-
crosoft®Excel. The results are saved in the directory of the script file, this is 
the subdirectory SpecialMeas of the FSHRemote installation directory by 
default. 

The following script file EXAMPLE_3.TXT was used to demonstrate the 
result file format 

#*************************** 
# FSHRemote script 
#*************************** 
cmd preset 
saveresults results.csv 
comment NewMeasurement 
set freq,98.5e6 
set span,20e6 
set mark1on,1 
get mark1 
comment StartLoop 
do 
pause 2 
comment i Next Peak 
cmd marknxtpk 
get mark1 
loop 3 
cmd local 
#end 

The results file RESULTS.CSV obtained with this script example looks like 
this:  

29.08.2004; 09:28:48,215;  <comment___>; NEWMEASUREMENT 
29.08.2004; 09:28:49,078;  <get mark1_>; 98500000; -49,17 
29.08.2004; 09:28:49,086;  <comment___>; STARTLOOP 
29.08.2004; 09:28:51,102;  <loopcount_>; 1; NEXT PEAK 
29.08.2004; 09:28:51,359;  <get mark1_>; 102300000; -52,7 
29.08.2004; 09:28:53,383;  <loopcount_>; 2; NEXT PEAK 
29.08.2004; 09:28:53,625;  <get mark1_>; 105766670; -54,07 
29.08.2004; 09:28:55,637;  <loopcount_>; 3; NEXT PEAK 
29.08.2004; 09:28:55,887;  <get mark1_>; 97633330; -55,74 

 

Every result is preceeded by date and time, when the result has been 
measured, followed by the command and the result. Since the command in 
this example was GET MARK1, the result contains the frequency and the 
measured level of the FSH Marker. 

 

Note: Results are appended to file RESULTS.CSV. Repeated execution 
of a script file results in increase of length of this file. Change file 
name in order to avoid this before running  the script again. 
Time resolution is 0.001 s, but this is not very exact due to Micro-
soft®Windows limitations. Use user defined format hh:mm:ss,000 
in Microsoft® Excel for calculations.  

Note: Files with trace data generated by appending several 
measurements cannot be loaded into the FSHView software. 
They work only in FSHRemote. 

 

Latest information on Special Measurement Mode can be found in the file 
history.rtf which is located in the installation directory. You can access this 
file also from link Programs/FSHRemote/History from the Start Programs 
folder of your PC. 
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12 Appendix D: Troubleshooting 

The FSHSim Diagnostics program 
In order to locate and fix a problem preventing normal communication be-
tween FSHRemote and the FSH spectrum analyzer, you can replace the 
FSH by a computer running the FSHSim diagnostics program. 

 

 

Fig 36 Replacing FSH spectrum analyzer by a computer running FSHSim 

 

FSHSim is a tool integrated within FSHRemote and has two main purposes: 

1. It simulates the behaviour of an FSH spectrum analyzer during the 
initial connection process. It connects to a port, listens to it and then 
replies as a FSH spectrum analyzer to the queries sent to it by 
FSHRemote: 

2. It also configures the modems and offers suggestions for remedy-
ing problems in modem communications. 

Note:  If you connect a PC instead of an FSH spectrum analyzer to a 
modem, the null modem (cross link) cable no longer needs to 
be used. In this instance, use a direct cable. 

 

Starting FSHSim 
There are two ways to start FSHSim: 

1. By selecting Utility -> Start FSHSim  
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Fig 37 Starting FSHSim 

 

2. From the Programs menu by clicking on its icon: 

 

Fig 38 Starting FSHSim 2 

Once FSHSim has been started its main window is displayed on the screen: 

 

Fig 39 FSHSim Main Window 
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Connecting FSHSim 
There are two types of ports to which you can connect FSHSim, according 
to the two main types of connections you can establish with FSHRemote. 
You can connect the program to a COM port or to a TCP/IP port. Use either 
the Connection menu or the quick buttons COM and TCP/IP on the upper 
left side of the main window. 

 

FSHSim for COM port connections 
Replace the FSH spectrum analyzer by a PC running FSHSim as shown 
below, and connect this PC to the remote modem: 

 

 

 

Fig 40 PC with FSHSim instead of a FSH 

 

Note:  Please use only a direct cable without Null modem adapter to 
connect modem and PC 

 

Connecting to a COM port: 

If the COM connection is selected the following dialog box is displayed: 
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Fig 41 Connecting FSHSim to a COM port 

 

FSHSim can automatically detect a modem when it connects to the se-
lected COM port. Check the option “Detect Modem” in the dialog box. If no 
modem is detected or the modem does not answer the query, an error 
message and a dialog box are displayed asking whether you want to reset 
the modem to its factory settings. Resetting is sometimes helpful as a previ-
ously made setting may prevent the modem from returning any answers to 
the queries. After pressing the Connect button, FSHSim issues a reset 
command. If this is also not successful, a list of possible reasons and 
suggestions for solving the problem will be displayed. The connection with 
the specified COM port is nevertheless activated, and you can send and re-
ceive any data through it. 

When the “Detect modem” option has been selected, the following dialog 
box is displayed after connecting: 

 

Fig 42 COM Port Connection 
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If the “Detect modem” option has not been selected then no initialization 
commands are sent to the COM port and the main text box of FSHSim re-
mains empty. 

Following reasons could prevent the computer from communicating with the 
modem: 

1. Improper physical connection (data cables not plugged in, etc.) 

2. Power supply not plugged into receptacle and modem therefore not 
powered up 

It is very unlikely that the modem itself is faulty, however this may occur. 
Checking modem operation is fairly simple when the modem is an external 
device. Generally, if the modem has failed its self tests on power-up, the 
front panel lights will indicate a problem. For example, if the MR (modem 
ready) light does not come on, the modem may have a problem. Or if the 
HS light (external Smartmodem and V-series System Products) does not 
come on, the modem may be incorrectly configured. Please check your 
modem manual for further information. 

Sometimes a modem failure may be caused by a power surge; an incom-
patible component in the communication link; an improper connection; or 
simply a device that is not plugged in or turned on. Before initiating the tests 
described in this chapter, re-examine the communications equipment to 
make sure none of the above conditions is causing the problem. 

 

Verifying the PC (DTE)-to-modem connection 

The first interface to verify is the one between the DTE and the modem. 
This involves the cable, the modem, and the DTE. 

1. Connect FSHSim to the COM port where the modem is connected to  
with the correct baud rate and the “Detect modem” option selected. An 
initialization command is sent to the modem and an answer is dis-
played. If successful, proceed with the following steps. Otherwise read 
the explanations on the screen. 

2. Press the Reset in FSHSim button in order to reset the modem to its 
factory settings (a command AT&F is sent to the modem). 

 

Verifying the connection of the modem to the telephone line 

Once you are certain that the modem is receiving and responding to com-
mands from the DTE, you can verify the modem's dialing capabilities by at-
tempting a call. This will also test the telephone lines. 

1. Try to dial an existing telephone number (preferrable of a phone in the 
same room or an available mobile phone) by entering the number in the 
Dial Number text box and click the Dial button. 

 

Fig 43 Dial Number 
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If your modem does not detect the dial tone FSHSim changes the mo-
dem settings automatically and dials the number again. 

If you hear your modem dialing, but you cannot hear a dial tone, then 
there is no connection between the modem and the telephone line. Af-
ter some seconds “NO CARRIER” will be displayed. 

2. If you hear the phone on the other end ringing, then the remote phone 
is responding properly. Press the Cancel button to hang up. 

3. You can check the modem's answering capabilities by dialing its phone 
number from another telephone or from another modem. If the modem 
receives a call the following should be displayed in the main text box of 
FSHSim: 

Received:  

<CR>  

RING<CR>  

4. Try dialing to another modem to see if you can make a connection. A 
connection is indicated by two whistling sounds of different tones (the 
carriers), followed by a hissing sound. The modem should respond with 
a CONNECT XXXXX result code. 

When connected you can use the Send button and its text box to send data 
to the remote modem or to the local one if not connected. The results are 
diplayed in the main text box. 

 

Fig 44 Send data manually 

Once these steps have been completed, both modems should be function-
ing correctly. If no errors have occurred within these steps, you can use the 
Utility -> Set Device dialog box in the same way as in FSHRemote to con-
figure the modem and try to establish a modem to modem connection be-
tween the PC running FSHRemote and the PC running FSHSim. In order to 
do this proceed with the following steps: 

1. Configure one of the two modems with the Set Device dialog box as if it 
is connected to a FSH spectrum analyzer, and reset the settings of the 
other modem. 

2. Connect the first modem with the PC running FSHSim and the second 
modem to the PC running FSHRemote. 

3. Connect FSHSim to the COM port of the modem. 

4. On the PC running FSHRemote select Connection -> Modem to mo-
dem connection and connect as described in the “Connecting the PC, 
FSH and Modems / Serial Server (LAN-RS232 Converter)” section. 

If the connection is successful, FSHRemote displays an artificial sweep on 
its screen transmitted by FSHSim. The FSHSim screen displays the log of 
the communication in its main text box allowing you to trace the queries and 
the responses during the initialization. In this way, certain problems such as 
inconsistencies in the baud rate can easily be uncovered. If an error occurs 
FSHSim offers an explanation for the cause and a possible solution. 
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Fig 45 The display after a successful connection 

 

You are now ready to reconnect the FSH to the modem instead of the PC 
running FSHSim. If you still receive the error message “No FSH found at 
the specified address” with no other explanations from FSHRemote or 
FSHSim, and despite a successful modem to modem connection, the 
problem is likely to stem from the connection between the modem and the 
PC running FSHSim. Please recheck the cabling, especially whether you 
really have a crosslink cable between modem and FSH.  
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Sometimes the signal levels from and to the modem are not high enough to 
drive the FSH, especially some modems cannot supply the power for the 
electronic in the optical RS232 cable. You can measure this with an 
oscilloscope, the signal levels should be higher than 5 volts. In this case 
please use the buffer amplifier described in Appendix A, "Recommended 
Wiring for a Buffer Amplifier" for modem to FSH connection.   

If the connection has been successful, you are ready to test it using a FSH 
spectrum analyzer: 

1. Reconfigure the modem in order to be able to connect to an FSH using 
the Utility->Set Device dialog box. 

2. Connect the FSH to the modem, instead of the PC, using a cable with  
opposite wiring (e.g. by adding an additional null modem adapter). 

3. Start FSHRemote on the other PC and use the Connection menu as 
previously described to connect. 

 

Using FSHSim for TCP/IP port connections 
If you want to test the network connection for a TCP/IP communication be-
tween FSHRemote and a FSH spectrum analyzer, proceed with the follow-
ing steps (explained in detail in following sections): 

1. Connect the computer running FSHSim directly to the network. 

2. Connect FSHSim to a TCP port on the computer to act as a listener. 

3. Test the connection between FSHRemote and FSHSim. 

4. Add a serial server (LAN-RS232 converter) between the computer run-
ning FSHSim and the network and connect FSHSim to the COM port of 
the serial server. 

 

FSHSim with a direct connection to the network: 

Connect the PC running FSHSim, which acts as an FSH spectrum ana-
lyzer, directly to the network without using a serial server: 

 

 

Fig 46 Direct connection to the network 

 

1. Start FSHSim, select the TCP/IP button and type in the port (in the dis-
played dialog box as described in the “Connecting FSHSim” section) 
through which you want to listen. 
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The following dialog box is displayed after selecting the TCP/IP con-
nection: 

 

Fig 47 Computers seen by TCP/IP connection 

 

It displays the current network settings of the PC and a list of other 
workstations connected to the same network and subnetwork. 

Please note that when you select this type of connection, in order to 
listen for a TCP/IP connection you are only asked to specify a TCP port 
and no IP address. This is because FSHSim uses the IP address allo-
cated to the PC. Should the list remain empty then no other stations are 
connected to the network, they are not visible or the settings are incor-
rect. (e.g. the subnet mask does not correspond to the current net-
work). Note that if you wish to connect to FSHSim via TCP/IP from the 
same LAN the other computer has to be visible in this list. 

2. Connect a PC running FSHRemote to a PC running FSHSim using the 
port and IP address of the PC running FSHSim. If this is unsuccessful, 
then there is no connection between the two PCs. Please refer to the 
section “TCP/IP connection with a serial server (LAN-RS232 converter) 
and a network connection”. 

 

FSHSim for a TCP/IP connection with a serial sever (LAN-RS232 con-
verter): 

 

Fig 48 Connecting FSHSim to the network via a serial server 
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In order to verify that the serial server has been properly configured and 
communicates with the network, connect the PC to the COM port of the se-
rial server as shown in fig 29. Make sure your serial server is configured 
properly and visible in the network as described in the section: “TCP/IP 
connection with a serial server (LAN-RS232 converter) and a network 
connection” (see page 11 of this application note). Then click on the COM 
button on the upper left side of the FSHSim main window and select the 
COM port of the PC and the baud rate for the connection (do not select the 
“Detect Modem” option). FSHSim then listens for data through the port and 
answers if the correct queries have been made (i.e. FSH K1 remote control 
commands). You can now run FSHRemote on a PC connected to the same 
network as the serial server (LAN-RS232 convertor) and establish a TCP/IP 
connection as described in the section “TCP/IP connection with a serial 
server (LAN-RS232 converter) and a network connection”. If the serial 
server has been properly configured the connection between FSHRemote 
and FSHSim should be successful.  

If not, check following items: 

1. IP/Port Connection: FSHRemote is not connected to the right IP/Port of 
the serial server – please refer to section “Configuring the communica-
tion devices”. 

2. The cable between the PC and the serial server: try using a null modem 
adapter or replace it in case it is faulty. 

3. The baud rate setting in the serial server is not the same as in FSHSim 
(the FSH spectrum analyzer respectively). This will be detected and re-
ported by FSHSim. In this case, change the setting of the baud rate and 
then try connecting again. The network settings of the serial server and 
of the PC running FSHRemote need not to be changed. 

After a successful TCP/IP connection between FSHRemote and FSHSim 
has been established, you are ready to test the connection with the FSH 
spectrum analyzer again. Proceed with the following steps: 

1. Connect the FSH to the serial server again, using an appropriate cable. 

2. Start FSHRemote on the other PC and use the Connection menu as 
previously described to connect. 
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Additional Notes 
FSHSim allows easy tracing of the communications between FSHSim and 
FSHRemote. Each received command and its response are displayed in 
detail with some additional comments. You can save this log into an .rtf 
(Rich Text Format) file and load these log files back into the text box by 
using the File->Save log and File->Load log menus or the quick buttons un-
derneath the text box: 

 

Fig 49 Log buttons 

 

The Clear button clears the contents of the main text box. 

To disconnect FSHSim and FSHRemote, use the button on lower left cor-
ner of FSHSim or Connection->Disconnect. 

 

13 Appendix E: Optical USB Interface Cable FSH-Z37 
The driver, which comes with the Optical USB interface cable FSH-Z37, 
emulates a COM interface. Check the number of this COM interface as 
described in the installation manual and use this COMx in FSHRemote for 
the direct connection of FSH to your PC. 

Different to RS-232, an USB interface is highly unsymmetrical. With USB, 
there are master devices and slaves. USB masters are built into computers, 
all peripheral devices such as printers and the optical interface cable FSH-
Z37 are slaves. Unfortunately all mobile phones and modems are slaves 
too. This means, these devices may only be connected to a computer, 
containing a USB master controller. A direct connection of FSH to a mobile 
phone or a modem as with RS-232, is not possible with USB. If your 
application needs the direct connection of FSH to a modem or mobile 
phone, please use RS-232-C interface cable FSH-Z34, order number 
1145.5815.02, which may be ordered separately form your Rohde&Schwarz 
representative.  
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